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1 Introduction

West LiveNote is software that allows you to view and work with deposition transcripts.

File Types for Importing Transcripts
You can import the following types of transcript files into West LiveNote:

• E-Transcript files (PTX or EXE)—transcript only format provided by court reporters; may include court 
reporter’s signature

• ASCII (text only) files—transcript only format

• Portable Transcript (PTF) files—used to move a transcript with annotations to another program that will 
accept that file type or another West Case Notebook or West LiveNote computer

• LiveNote Evidence Format™ (LEF™) files—contain the transcript with linked exhibit files; may contain 
synchronized video

• Publisher Bundle (bundle.xml) files—contain the transcript with linked exhibit files; may contain 
synchronized video

• E-Transcript Bundle (PTZ) files—created with West Publisher version 5 or later; contain the transcript with 
linked exhibit files; may contain synchronized video

• Extensible Markup Language (XML) files—contain the transcript with linked exhibit files; may contain 
synchronized video

• CT Summation (TRN) files

• Timaro Technologies Post-Production Time-Stamp (PTS) files 

Getting Help
Online Help is available in West LiveNote to assist you. Simply click Contents on the Help menu. 

You can also easily access free online lessons and webinars to help you learn West LiveNote. On the Help menu, 
click Online Lessons to display the West eLearning Center page. Once you have logged in, click West Case 
Notebook in the left frame.
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2 Managing Cases 

Creating a New Local Case 
Cases in West LiveNote can be created for one person to use (local cases), or they can be created through the 
West LiveNote Administration module to be available on a network so they can be shared (secure cases). Local 
cases can be imported through the West LiveNote Administration module to also make them shareable. 

To create a new case, follow these steps: 

1. Access West LiveNote to display the Open Case dialog box (Figure 2-1). 

Figure 2-1. Open Case dialog box

2. Click New to display the Save As dialog box. 

3. Select the location to use for storage of the case; type the file name, e.g., smithvjones; and click Save. The 
New Case Properties dialog box is displayed. 

4. Type the name of the case, e.g., Smith v Jones, in the Name text box.

5. Click OK. 

The case window, which lists all the transcripts for the case, is displayed (Figure 2-2). 

Figure 2-2. Case window

CREATING A NEW CASE FROM AN OPEN CASE

To create a new case from an open case, complete these steps:

Main 
Menu 
toolbar
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1. Click the New arrow on the Main Menu toolbar and choose Case from the menu. The Save As dialog box is 
displayed. 

2. Select the location to use for storage of the case; type the file name, e.g., smithvjones; and click Save. The 
New Case Properties dialog box is displayed. 

3. Type the name of the case, e.g., Smith v Jones, in the Name text box.

4. Click OK. 

Opening a Local Case
To open a case, choose Open Case from the File menu to display the Open Case dialog box. Select your case 
from the list and click OK. 

Importing a Case
To import a case, complete these steps:

1. Click the New arrow, then choose Case (from File) from the menu. The Open dialog box is displayed.

2. Select your case and click Open. The Save As dialog box is displayed. 

3. Type a name for the file in the File name text box.

4.  Click Save. The message Would you like to add the new case to your case list8 is displayed. Click Yes. The case 
is displayed in the case window. 

Opening a RealLegal Binder Case
You can open a RealLegal Binder case, version 5 or later, in West LiveNote. To open a RealLegal Binder case, 
complete these steps:

1. Choose Open Case from the File menu to display the Open Case dialog box.

2. Click Add. The Open dialog box is displayed. 

3. Select the RealLegal Binder Case (PXL) file you want to import and click Open.

4. The message This case was created with RealLegal Binder. It must be imported before it can be used. Do you 
want to continue? is displayed. Click Yes. The Save As dialog box is displayed.

5. Type a name for the file in the File name text box and click Save. The case is listed in the Open Case dialog 
box.

6. Select the case and click OK.

Note The RealLegal Binder case opens as a local case with no assigned users. For further information on the 
conversion of RealLegal Binder cases to West LiveNote cases, see Appendix B.

Accessing Secure Cases 
Note

• If you are working on a secure case with other users, all users must use the same version of West LiveNote. 
For example, if a secure case is upgraded to West LiveNote version 2.5, all users working on the case must use 
West LiveNote version 2.5.

• If you are working in a West LiveNote 2.5 case, then revert to using West LiveNote version 1.0, you must 
manually rebuild the search index for the case. To rebuild the search index, choose Advanced, Rebuild 
Search Index from the Tools menu.

To access a secure case, complete these steps:
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1. Access West LiveNote. Or in an open case, choose Open Case from the File menu. The Open Case dialog box 
is displayed (Figure 2-3).

Figure 2-3. Open Case dialog box

2. Click Repositories. The Repositories dialog box is displayed (Figure 2-4).

Figure 2-4. Repositories dialog box

3. Select the repository that you want to log on to and click Logon. The Logon to [Repository Name] dialog box 
is displayed (Figure 2-5). 

Figure 2-5. Logon to [Repository Name] dialog box

4. Type your username and the password that is assigned to you in West LiveNote Administration in the 
Username and Password text boxes. 

5. Select the Remember my logon settings check box if you want West LiveNote to remember your username 
and password.
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6. Click OK. The Repositories dialog box is redisplayed (Figure 2-6).

8
Figure 2-6. Repositories dialog box

7. Click Close. The Open Case dialog box is redisplayed with a list of the cases to which you are assigned 
(Figure 2-7).

 
Figure 2-7. Open Case dialog box

Note Two types of case icons may be displayed: 

• A brown case icon ( ) indicates a local case or a secure case that is currently being accessed through the 
network. 

• A brown and blue case icon ( ) indicates a secure case that was replicated offline and is currently being 
accessed locally. 

To view only secure cases, choose List Cases by Repository from the drop-down list at the top of the dialog 
box, then click the plus symbol (+) next to the repository containing the cases you want to view. 

8. Select your case and click OK. 

ACCESSING SECURE CASES THROUGH WEST LIVENOTE RAS

West LiveNote RAS (remote access server) provides remote access to your West LiveNote cases via the Internet. 
When you access a case remotely, most of the features in West LiveNote are available. When you finish working 
on a case, your changes are saved to the server. After you close a remote case, you must log on to another remote 
session to access the case again. 

When you use West LiveNote RAS, you cannot:

• copy a case

• administer remote cases using West LiveNote Administration

• connect to Realtime

Note To connect to Realtime in a case you access through West LiveNote RAS, you must replicate the case 
offline.

To access a secure case through West LiveNote RAS, complete steps 1 through 8 above.
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Viewing a List of Favorite Secure Cases
When you access secure cases in West LiveNote, all of the cases to which you are assigned are listed in the Open 
Case dialog box. You can add one or more of these cases to your list of favorite cases, then view only those cases 
when you access West LiveNote. 

To view your list of favorite cases, complete these steps:

1. Access secure cases. The Open Case dialog box is displayed with the list of the cases to which you are 
assigned (Figure 2-8). 

Figure 2-8. Open Case dialog box

2. Right-click the case you want to add to your list of favorite cases, e.g., Clelland v Anderson, and click Add to 
My Favorite Cases.

3. Choose List My Favorite Cases from the drop-down list at the top of the dialog box. Your list of favorite 
cases is displayed (Figure 2-9).

Figure 2-9. List of favorite cases

Replicating Cases Offline and to the Network
Note If you replicate a case offline on one computer and want to access the case via the network on a different 

computer, you must have a separate username assigned to you in the repository for each computer.

REPLICATING A CASE OFFLINE

You can work on a secure case off the network by replicating the case offline in West LiveNote. To replicate a 
secure case that you are currently working on offline, complete these steps:
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1. From the File menu, choose Replicate Case Offline. The Replication Wizard–Case Data dialog box is 
displayed (Figure 2-10).

Figure 2-10. Replication Wizard–Case Data dialog box

2. By default, all transcripts and documents are selected. To exclude a document type from being replicated 
offline, clear its check box. To exclude particular data from the report, click the document type containing 
the data, then clear the check boxes for the data you want to exclude.

3. Click Groups to add the data you selected to a data group. The Data Groups dialog box is displayed. Select 
the group to which you want to add the data and click OK.

Note You can use data groups to organize data in categories, which are displayed as folders under data 
categories in the left pane. For more information on data groups, see ”Working with Data Groups” on 
page 34.

4. Click Finish. The Cases Replicated to Offline dialog box is displayed, informing you that the case was 
successfully replicated offline. 

5. Click one of the following:

• Open Case. The case is displayed in the left pane.

• Close. The case is closed.

REPLICATING A CASE TO THE NETWORK

To replicate a case you are currently working on to the network, complete these steps:

1. From the File menu, choose Replicate Case Online. The Cases Replicated to Network dialog box is 
displayed.

2. Click one of the following:

• Open Case. The case is displayed in the left pane.

• Close. The case is closed. 

REPLICATING MULTIPLE CASES OFFLINE

To replicate multiple cases offline, you must first change your replication options, then close West LiveNote and 
select the cases you want to replicate offline. To replicate multiple cases offline, complete these steps:
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1. Choose Options from the Tools menu. The Options dialog box is displayed.

2. On the Confirmation tab, select the Replicate offline on closing West LiveNote check box, then click OK.

3. Close West LiveNote. The Replication Wizard–Cases dialog box is displayed (Figure 2-11).

Figure 2-11. Replication Wizard–Cases dialog box 

4. By default, all the cases on the network that are assigned to you are selected. To exclude a case from being 
replicated offline, clear its check box.

5. Click Next. The Replication Wizard–Case Data dialog box for the first case you selected is displayed. 

6. By default, all transcripts and documents are selected. To exclude a document type from being replicated 
offline, clear its check box.

7. Click Groups to add the data you selected to a data group. The Data Groups dialog box is displayed. Select 
the group to which you want to add the data and click OK.

Note You can use data groups to organize data in categories, which are displayed as folders under data 
categories in the left pane. For more information on data groups, see ”Working with Data Groups” on 
page 34.

8. Click Next. If you selected more than one case, the Replication Wizard–Case Data dialog box for the next 
case you selected is displayed.

9. Repeat steps 6–8 for each case you want to replicate offline.

10. When you have finished selecting the document types for all the cases you want to replicate offline, click 
Finish. The Cases Replicated to Offline dialog box is displayed, informing you that the cases were 
successfully replicated offline.

11. Click Close. West LiveNote is closed.
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REPLICATING MULTIPLE CASES TO THE NETWORK

1. If you replicated cases offline, the next time you access West LiveNote, the Replication Wizard–Offline Cases 
dialog box is displayed (Figure 2-12).

Figure 2-12. Replication Wizard–Offline Cases dialog box

2. By default, all the cases that you replicated offline are selected. To exclude a case from being replicated to 
the network, clear its check box.

3. Click Finish. The Cases Replicated to Network dialog box is displayed.

Figure 2-13. Cases Replicated to Network dialog box 

4. Select a case, then click one of the following:

• Open Case. The case is displayed in the left pane.

• Close. The case is closed. 

Changing Replication Options
West LiveNote has replication options that prompt you to replicate the case offline when you close West LiveNote 
or replicate the case to the network when you open West LiveNote. To change these options, complete these 
steps:
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1. From the Tools menu, choose Options. The Options dialog box is displayed (Figure 2-14).

Figure 2-14. Options dialog box

2. Select the Replicate offline on closing West LiveNote check box, if desired.

3. Clear the Replicate to the network on opening West LiveNote check box, if desired.

4. Make your selection the default, if desired.

5. Click OK. 

Creating a Case Report
This report includes the names of transcripts and any comments about the transcripts. To create a Case report, 
complete these steps:

1. Click the Report button ( ) on the Main Menu toolbar, then choose Case from the menu. The Case 
Report Properties dialog box is displayed (Figure 2-15).By default, all transcripts and documents are 
selected. To exclude a document type from the report, clear its check box. To exclude particular data from 
the report, click the document type containing the data, then clear the check boxes for the data you want to 
exclude.

Figure 2-15. Case Report Properties dialog box 
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2.  Click Groups to include only the data in a data group in your report. Select the group you want to include in 
your report and click OK. For further information on data groups, see ”Working with Data Groups” on page 
34.

3. Click the Display tab to view a list of display options. Type a title for the report in the Title text box, if desired. 
Then select or clear the appropriate check boxes.

4. Clear the Include cover page when printing or saving check box, if desired.

5. Click OK. The Case report is listed under Report in the left pane and the text of the report is displayed on the 
Report tab in the right pane.
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3 Managing Transcripts 

Importing a Transcript
To import a transcript, complete these steps: 

1. Click the New arrow on the Main Menu toolbar and choose Transcript (from File) from the menu. The Import 
Wizard–Transcript File dialog box is displayed. 

2. Click Browse to display the Browse for Transcript Files dialog box. 

3. Choose a file type from the Files of type drop-down list. Then select your transcript and click Open. The 
Import Wizard–Transcript File dialog box is redisplayed. 

4. Click Next. A message warning that the transcript has not been signed electronically may be displayed. Click 
Continue. The Import Wizard–Transcript Properties dialog box is displayed (Figure 3-1). 

Figure 3-1. Import Wizard–Transcript Properties dialog box

5. Type a comment in the Comment text box, if desired.

6.  Click Groups to add the transcript to a data group. The Data Groups dialog box is displayed. Select the 
group to which you want to add the data and click OK. The Import Wizard–Transcript Properties dialog box 
is redisplayed.

Note You can use data groups to organize data in categories, which are displayed as folders under data 
categories in the left pane. For more information on data groups, see ”Working with Data Groups” on 
page 34.
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7. Click Finish. The Import Wizard–Import Summary dialog box is displayed. To import another transcript, click 
Again. If you do not want to import another transcript, click Close. The transcript is listed under Transcripts 
in the left pane and the text of the transcript is displayed in the right pane (Figure 3-2).

Figure 3-2. Imported transcript

Note If you see  next to the transcript, the transcript has been signed.

Opening an Existing Transcript 
To open a transcript, complete these steps:

1. If necessary, click Transcripts in the left pane to display a list of all transcripts in the case.

2. Double-click the transcript you want to open. The text of the transcript is displayed in the right pane.

Closing a Transcript
To close a transcript so that it is no longer displayed in the right pane, click the Close button ( ) on the 
transcript’s tab.

Deleting a Transcript 
To delete a transcript, right-click the transcript in the left pane and choose Delete from the menu. The message 
Permanently delete the selected Transcript and all associated Annotations? is displayed. Click Yes.

Printing a Transcript with Annotations
You can display annotations, Quick Marks, and Issue Marks in printed transcripts. For condensed transcripts, you 
can also print annotations, including notes and author information, in the footer of the document. To print a 
transcript with annotations in the footer of the document, complete these steps:

1. Open the transcript you want to print.

2. Click the Print arrow on the toolbar above the transcript and choose Print Preview Condensed from the 
menu. The Print Preview dialog box is displayed.

3. Click the Properties icon ( ) to display the Page Setup–Condensed Transcript dialog box (Figure 3-3).
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4. Click the Annotations tab (Figure 3-3).

Figure 3-3. Page Setup–Condensed Transcript dialog box–Annotations tab

5. Select the Display Annotations check box, if necessary. 

6. To include or exclude annotations associated with specific issues from the printed transcript, click Select 
Issues. The Select Issues dialog box is displayed. Issues will be listed in this dialog box only if they have 
previously been created. See ”Working with Issues” on page 20.

7. Select or clear the check boxes next to the issues you want to include or exclude and click OK. The Page 
Setup–Condensed Transcript dialog box is redisplayed.

8. Clear the Include Quick Marks check box, if desired.

9. Clear the Include Annotations with no Issues check box, if desired.

10. Choose how you want the annotations displayed in the transcript text from the Display drop-down list.
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11. Click OK. The transcript with its annotations is displayed (Figure 3-4). 

Figure 3-4. Preview of transcript with annotations

Note Overlapping annotations are highlighted in gray. The Annotation Range is available in the footer to 
help you determine the length of the overlapping annotations.

12. Click the Print icon to print the transcript.
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4 Updating Transcripts 

West LiveNote transcripts can be updated using the following types of files: 

• E-Transcript (PTX or EXE) files—files containing transcript text and, if the transcript is signed, the signature 
details

• ASCII (text only) files—files containing transcript text, usually received from the court reporter 

• Portable Transcript (PTF) files—files containing transcript text and annotations, usually received from 
another West LiveNote user 

• LiveNote Evidence Format (LEF) files—files containing transcripts, exhibits, exhibit links, and possibly 
synchronized video 

Note You can also import CT Summation (TRN) files and Timaro Technologies Post-Production Time-Stamp 
(PTS) files. 

Any annotations, including Quick Marks and Issue Marks, are automatically transferred to the updated transcript. 
No work product will be lost because all annotations are linked to the transcript text, not to the page and line 
references. Therefore, annotations made in the old transcript are simply transferred to the same text location in 
the updated transcript. 

Starting the Updating Process
To update an transcript, you must first assign draft status to the transcript. To assign draft status to a transcript, 
complete these steps:

1. Click the Transcript Properties button ( ) on the toolbar above a transcript in the right pane to display the 
Transcript Properties dialog box. 

2. Choose Draft from the Status drop-down list.

3. Click OK. 

Updating with a PTX or EXE File
1. Click the Update Transcript button ( ) on the toolbar above a transcript in the right pane. The 

Update Transcript–Transcript File dialog box is displayed. 

2. Click Browse to display the Browse for Transcript Files dialog box. 

3. Select the PTX or EXE file that was sent to you and click Open. The Update Transcript–Transcript File dialog 
box is redisplayed. 

4. Click Next. A message warning that the transcript has not been signed electronically may be displayed. Click 
Continue. The Update Transcript–Transcript Properties dialog box is displayed.

5. Click Finish. The Update Transcript–Update Completed dialog box is displayed.

6. Click Close. 

Updating with an ASCII File 
1. Click the Update Transcript button ( ) on the toolbar above a transcript in the right pane. The 

Update Transcript–Transcript File dialog box is displayed. 

2. Click Browse to display the Browse for Transcript Files dialog box. 

3. Select the ASCII file that was sent to you and click Open. (Different CAT systems create different extensions 
on ASCII files.) The Update Transcript–Transcript File dialog box is redisplayed. 
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4. Click Next. A message warning that the transcript has not been signed electronically may be displayed. Click 
Continue. The Update Transcript–Import Details dialog box is displayed.

5. Click Next. The Update Transcript–Import Confirm dialog box is displayed. 

6. Click Next. The Update Transcript–Transcript Properties dialog box is displayed.

7. Click Finish. The Update Transcript–Update Completed dialog box is displayed.

8. Click Close.

Updating with a PTF File 
Use this method when you want to merge two sets of annotations into one transcript when replication is not 
available. 

1. Click the Update Transcript button ( ) on the toolbar above a transcript in the right pane. The 
Update Transcript–Transcript File dialog box is displayed. 

2. Click Browse to display the Browse for Transcript Files dialog box. 

3. Select the PTF file and click Open. The Update Transcript–Transcript File dialog box is displayed.

4. The Replace existing text with new text check box is automatically selected. If there are no changes to the text 
and you want to only merge annotations, clear the check box. 

5. The Import Annotations check box is automatically selected. If you want to only replace text and not merge 
annotations, clear the check box.

6. Under Import Annotations, Add to existing annotations is automatically selected. This is the correct 
selection for merging annotations. Select Replace existing Annotations if you want to replace one set of 
annotations with another set.

7. Click Next. A message warning that the transcript has not been signed electronically may be displayed. Click 
Continue. The Update Transcript–Transcript Properties dialog box is displayed. 

8. Click Finish. The Update Transcript–Update Completed dialog box is displayed.

9. Click Close. 

Updating with a LEF File 
LEF files may contain the transcript with exhibit files and links to exhibit references in the transcript, the 
transcript with exhibit files and links to exhibit references in the transcript and synchronized video, or the 
transcript with synchronized video but no exhibits or exhibit links. 

1. Click the Update Transcript button ( ) on the toolbar above a transcript in the right pane. The 
Update Transcript–Transcript File dialog box is displayed. 

2. Click Browse to display the Browse for Transcript Files dialog box. 

3. Select the LEF file and click Open. The Update Transcript–Transcript File dialog box is redisplayed. 

4. The Replace existing text with new text check box is automatically selected. If there are no changes to the 
transcript text, clear the check box. 

5. The Import exhibits check box is automatically selected. If you do not want to import exhibits, clear the check 
box. 

6. The Import Annotations check box is automatically selected. If you do not want to import annotations, clear 
the check box.

7. Under Import Annotations, Add to existing Annotations is automatically selected. This is the correct 
selection for merging the annotations. Select Replace existing Annotations if you want to replace one set of 
annotations with another set.
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8. Click Next. A message warning that the transcript has not been signed electronically may be displayed. Click 
Continue. The Update Transcript–Transcript Properties dialog box is displayed. 

9. Click Finish. The Update Transcript–Update Completed dialog box is displayed.

10. Click Close.
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5  Working with Issues 

An issue is a type of annotation that relates to a particular subject. (For more information on annotations, see 
”Working with Annotations” on page 24.) Categorizing annotations in a case by issue makes it easy to retrieve all 
testimony on a specific subject when you need it. Issues are created for each case and are the same for all users 
of that case. When creating new issues, it is important to not duplicate previous issues.

Although the issues in a case are the same for all users, each user can choose the issues to display on the Main 
Menu toolbar. The Main Menu toolbar enables you to access issues quickly when creating annotations. You can 
display up to 10 issues on the Main Menu toolbar. 

Creating Issues 
To create an issue, complete these steps: 

1. Click the Manage Issues button ( ) on the Main Menu toolbar. The Manage Issues dialog box is displayed 
(Figure 5-1).

2. Click New to display the New Issue dialog box.

3. Type the name of the issue, e.g., Work history, in the Issue text box. 

4. Click the Color arrow to select a color for the issue, if desired.

5. Click Repeat if you are creating multiple issues. 

6. When you finish creating issues, click OK in the New Issue dialog box. The issues are listed under All Issues in 
the Manage Issues dialog box.

Figure 5-1. Manage Issues dialog box

CREATING SUB-ISSUES 

You can create sub-issues, which are a subset of existing issues.You can add up to three levels of sub-issues. 

To create a sub-issue, complete these steps:

1. Click the Manage Issues button ( ) on the Main Menu toolbar. The Manage Issues dialog box is displayed.
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2. Click the # button ( ), if it is not already selected, to display numbers next to the issues 
(Figure 5-2).

Figure 5-2. Manage Issues dialog box

3. Under All Issues, select the issue, e.g. Work history, for which you want to create a sub-issue.

Note If you do not select an issue, the sub-issue is added to the bottom of the list. 

4. Click New to display the New Issue dialog box.

5. Type the name of the issue, e.g., Missed work, in the Issue text box. 

6. Click the Color arrow to select a color for the issue, if desired.

7. Click Repeat if you are creating multiple sub-issues. 

8. When you finish creating sub-issues, click OK in the New Issue dialog box. The sub-issues are listed under 
the issue you selected.

9. Select the sub-issue, if necessary, then click the Increase Indent button ( ). The sub-issue is indented 
under the issue and the sub-issue number becomes sequential to the issue number. 

To remove the sub-issue from under the issue, click the Decrease Indent button ( ).

Prioritizing Issues
To prioritize an issue or sub-issue and add it to the Main Menu toolbar, complete these steps: 

1. Click the Manage Issues button on the Main Menu toolbar. The Manage Issues dialog box is displayed.

2. Select an issue or sub-issue under All Issues, e.g., Work history. 

3. Click the left arrow to move the issue or sub-issue under My Top Issues.

4. Repeat steps 2 and 3 for each issue or sub-issue you want to prioritize and add to the Main Menu toolbar. 
You can prioritize up to 10 issues and sub-issues (Figure 5-3). 

5. To reprioritize an issue or sub-issue and change its order on the Main Menu toolbar, select the issue or sub-
issue under My Top Issues and click the up arrow or down arrow.
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6. Click OK when you finish prioritizing the issues or sub-issues. 

Figure 5-3. Prioritizing issues

Importing Issues
You can create a list of issues in any word-processing program that can save files as XML (Extensible Markup 
Language) files. To import issues and sub-issues from a file, complete these steps: 

1. Click the New arrow on the Main Menu toolbar, then choose Issues (from File) from the menu. The Open 
dialog box is displayed. 

2. Select the file containing the issues you want to import and click Open. 

3. The message Issues were successfully imported from the chosen file is displayed. Click OK. 

Exporting Issues
To export issues to  a file, complete these steps: 

1. Choose Save As, Issues from the File menu. The Save As dialog box is displayed. 

2. Select a location for the file.

3. Type a name for the file in the File name text box. 

4. Choose a file type from the Save as type drop-down list.

5. Click Save. 

Creating an Issues Report 
This report lists all of the issues in a transcript, grouped by issue and then arranged in page and line order. To 
create an Issues report, complete these steps: 
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1. Click the Report button ( ) on the Main Menu toolbar, then choose Issues from the menu. The Issues 
Report Properties dialog box is displayed (Figure 5-4). 

Figure 5-4. Issues Report Properties dialog box 

2. All of the issues in the case are selected on the Issues tab by default. To remove an issue from the report, 
clear its check box.

3. Select the Only include Annotations with all selected issues (“Match all Issues”) check box, if desired.

4. Select the Only include Annotations that contain notes check box, if desired.

5. Click the Data tab to display a list of transcripts and documents. By default, all document types and data are 
selected. To exclude a document type from the report, clear its check box. To exclude particular data from 
the report, click the document type containing the data, then clear the check boxes for the data you want to 
exclude. 

6. Click the Display tab to view a list of display options. Type a title for the report in the Title text box, if desired. 
Then select or clear the appropriate check boxes. 

7. Click the Context tab to display a list of context options. Select or clear the appropriate check boxes. 

8. Click the Authors tab to display a list of annotation authors. If you are working in a secure case on a network, 
a list of all annotation authors is displayed. If you are working in the case offline, just LocalUser is displayed. 
Select or clear the appropriate check boxes.

9. Click OK. The Issues report, which includes the lines you marked and the surrounding questions and 
answers, is listed under Report in the left pane and the text of the report is displayed on the Report tab in the 
right pane.
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6 Working with Annotations 

An annotation is a highlighted portion of transcript text. It may be associated with an issue; a note (a comment 
associated with an annotation); or an attachment, e.g., a document or image. 

Adding an Issue Annotation Using the Main Menu Toolbar 
To add an annotation associated with an issue using the Main Menu toolbar, complete these steps: 

1. Make certain the Apply Issue Mode button ( ) is displayed on the toolbar above the transcript in the right 

pane. To display the Apply Issue Mode button, click the Annotate Mode button ( ) on the toolbar above 
the transcript and choose Apply Issue Mode from the menu. 

Note The Annotate Mode button is the default button.

2. Click an issue button on the Main Menu toolbar to select the issue and assign it to the annotation you are 
adding. 

3. Select the text you want to annotate. The text is highlighted with the color of the issue you selected (Figure 
6-1). The issue will be assigned to every annotation you create until you cancel its selection on the Main 
Menu toolbar. 

Note You can select more than one issue on the Main Menu toolbar. Annotated text will be highlighted with the 
color of the last issue that you select. 

Figure 6-1. Annotated text

Adding an Annotation Using the Annotation Properties Dialog Box
You can use the Annotation Properties dialog box to add an annotation associated with a note, issue, 
attachment, or a combination of these. To view the Annotation Properties dialog box, make certain the Annotate 

Apply Issue 
Mode button
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Mode button ( ) is displayed on the toolbar above the transcript in the right pane. Then select the text in 
transcript you want to annotate. The Annotation Properties dialog box is displayed (Figure 6-2). 

Figure 6-2. Annotation Properties dialog box 

ADDING A NOTE TO AN ANNOTATION

The Note tab is the default tab in the Annotation Properties dialog box. To add a note to the annotated text, type 
the note in the Note text box and click OK.

ADDING AN ISSUE TO AN ANNOTATION

To associate an issue with an annotation, complete these steps: 

1. Click the Issues tab in the Annotation Properties dialog box. A list of prioritized issues (those that appear on 
the Main Menu toolbar) is displayed under My Top Issues and a list of all issues is displayed under All Issues. 

2. To assign one or more issues to the annotation, select the appropriate check boxes. Note that the check 
boxes for any issues you previously selected on the Main Menu toolbar are already selected. 

3. Click OK. The annotated text is highlighted with the color of the issue you selected.

ADDING AN ATTACHMENT TO AN ANNOTATION

To add an attachment to an annotation, complete these steps:

1. Click the paper clip icon ( ) in the Annotation Properties dialog box. The Edit Attachment dialog box is 
displayed.

2. Click Browse to display the Open dialog box is. Select your document and click Open. The Edit Attachment 
dialog box is redisplayed.

3. Click OK.

4. Click OK again in the Annotations Properties dialog box. For transcripts, a paper clip icon is displayed next 
to the annotation (Figure 6-3). To view the attachment, click the paper clip icon.

Figure 6-3. Paper clip icon in a transcript
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ASSOCIATING VIDEO WITH AN ANNOTATION 

You can associate video with an annotation if the transcript has been synchronized with video footage. For 
further information, see ”Working with Video in Transcripts” on page 45.

Transferring Annotations 
You can transfer an annotation to another application such as Microsoft Word, Corel WordPerfect, or 
TrialDirector using either of the following methods:

• Click Send in the Annotation Properties dialog box, then choose the application from the menu. 

• Right-click in the annotation and choose Send from the menu, then choose the application from the 
submenu.

To transfer an annotation that is associated with a video to PowerPoint, see ”Transferring Annotations to 
Microsoft PowerPoint” on page 46.

Sending Annotations to Instant Messages
To send an annotation to a team member during an instant messaging session, complete these steps:

1. Click Send in the Annotation Properties dialog box, then choose Realtime Chat from the menu.

2. Click OK. The annotation is displayed in the Annotation text box under Stream in the left pane. 

3. Click Send to send the annotation to your chat group. Or choose an individual from the Send To drop-down 
list and click Send. 

4. Repeat steps 1–3 for each annotation you want to send (Figure 6-4).

Figure 6-4. Sending an annotation to an instant message

Editing Annotations 
To change the information associated with an annotation, right-click in the annotation and choose Edit 
Annotation from the menu. The Annotation Properties dialog box is displayed. Make the appropriate changes 
and click OK.

Deleting Annotations 
To delete an annotation, right-click in the annotation and choose Delete Annotation from the menu. The 
message Permanently delete the selected Annotation? is displayed. Click Yes. 

Viewing an Annotation Attachment 
To view an annotation attachment, right-click in the annotation and choose Open Attachment from the menu. 

Click Send to 
send the 
annotation to 
your chat group.
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Creating an Annotations Report 
You can generate a report that includes a list of all the annotations in a transcript, arranged in page and line 
order. It also includes the surrounding questions and answers. 

To create an Annotations report for the transcript you are viewing, right-click the Annotations folder in the left 
pane and click Report. The report is listed under Report in the left pane and the text of the report is displayed on 
the Report tab in the right pane (Figure 6-5). 

Click the Hit arrows in the left pane to view the next or previous annotation in the report. Click the heading next 
to a transcript icon in the report to go to the location in the transcript where the annotation appears.

Figure 6-5. Annotations report

To create an Annotations report for one or more transcripts, complete these steps: 

1. Click the Report button ( ) on the Main Menu toolbar, then choose All Annotations from the menu. 
The All Annotations Report Properties dialog box is displayed (Figure 6-6). 

Figure 6-6. All Annotations Report Properties dialog box
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2. All of the issues in the case are selected on the Issues tab by default. To exclude an issue from the report, 
clear its check box.

3. Clear the Include Quick Marks check box, if desired.

4. Clear the Include Annotations with no Issues check box, if desired.

5. Select the Only include Annotations with all selected issues (“Match all Issues”) check box, if desired.

6. Select the Only include Annotations that contain notes check box, if desired.

7. Click the Data tab to display a list of transcripts and documents. By default, all document types and data are 
selected. To exclude a document type from the report, clear its check box. To exclude particular data from 
the report, click the document type containing the data, then clear the check boxes for the data you want to 
exclude. 

8. Click the Display tab to view a list of display options. Type a title for the report in the Title text box, if desired. 
Then select or clear the appropriate check boxes. 

9. Click the Context tab to display a list of context options. Select or clear the appropriate check boxes. 

10. Click the Authors tab to display a list of annotation authors. If you are working in a secure case on a network, 
a list of all annotation authors is displayed. If you are working in the case offline, just LocalUser is displayed. 
Select or clear the appropriate check boxes.

11. Click OK. The Annotations report, which includes the lines you marked and the surrounding questions and 
answers, is listed under Report in the left pane and the text of the report is displayed on the Report tab in the 
right pane. 

CREATING A VERBATIM DIGEST REPORT 

This is an Annotations report that includes only highlighted transcript text. To create a Verbatim Digest report, 
first create an Annotations report. Then click the Properties button ( ) on the toolbar above the report in 
the right pane to display the All Annotations Report Properties dialog box. Click the Display tab and clear all 
check boxes under Annotations. Then, click the Context tab. Under Transcripts, select the Show annotated text 
check box and clear the Additional context check box, then click OK.

CREATING A NOTES REPORT 

This report lists all of the annotations in a transcript that have a note, arranged in page and line order. To create 
a Notes report, first create an Annotations report. Then click the Properties button ( ) on the toolbar 
above the report in the right pane to display the All Annotations Report Properties dialog box. On the Issues tab, 
select the Only include Annotations that contain notes check box and click OK.

CREATING AN ATTACHMENTS REPORT 

This report lists all of the annotations in a transcript that have an attachment, arranged in page and line order. 
To create an Attachments report, first create an Annotations report. Then click the Properties button ( ) 
on the toolbar above the report in the right pane to display the All Annotations Report Properties dialog box. On 
the Issues tab, clear the Include Quick Marks check box. Then click the Display tab. Clear all check boxes under 
Annotations except the Attachments check box, then click OK.
28      Working with Annotations



7 Working with Full Text Search 

The Full Text Search feature enables you to search one or more transcripts in the open case for specific terms. 

Creating a Full Text Search 
You can enter a search that consists of key terms from your issue and connectors specifying the relationship 
between those terms. To create a search, complete these steps: 

1. From the Search menu, choose Full Text Search. The Full Text Search Properties dialog box is displayed 
(Figure 7-1).

Figure 7-1. Full Text Search Properties dialog box

2. Formulate your search by choosing search terms significant to your issue and deciding which connectors to 
place between your terms. To retrieve variations of terms, use the root expander (!) and the universal 
character (*). To retrieve a phrase, place quotations marks (“ ”) around the phrase. 

For more information on creating a search, see ”Formatting a Full Text Search” on page 30.

3. Type your search, e.g., document /20 handwritten, in the Terms text box. Or choose a search from the 
Recent drop-down list. 

4. Click the Data tab to display a list of transcripts, documents, and annotation notes. By default, all document 
types and data are selected. To exclude a document type from the search, clear its check box. To exclude 
particular data from your search, click the document type containing the data, then clear the check boxes for 
the data you want to exclude.
Working with Full Text Search      29



5. Click OK. Information about the search is displayed under Search Results in the left pane (Figure 7-2). 

Figure 7-2. Full Text Search result

To work with your search result, you can

• click a line in the result list to display that place in the result

• click Edit ( ) to edit your search

• click Report ( ) to create a report for your search result

• click the Term ( ) arrows to view the next or previous search term in your result

• click the Sort by arrow to sort your search result (Figure 7-3)

Figure 7-3. Sort by list

Formatting a Full Text Search 

USING THE ROOT EXPANDER

Use the root expander (!) to retrieve words with variant endings. The root expander must always be placed at the 
end of a term. For example, 

Plurals and possessive forms are automatically retrieved without a root expander.

Type To retrieve

contribut! contribute
contributed
contributor
contributing
contribution
contributory
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USING THE UNIVERSAL CHARACTER

Use the universal character (*) to represent one variable character. You can place the universal character 
anywhere in a term except at the beginning. For example,

Note When you place one or more universal characters at the end of a term, you specify the maximum length of 
that term.

USING CONNECTORS

Use connectors to specify the relationships that should exist between search terms in your retrieved transcripts. 

Creating a Search Report 
This report lists the result retrieved when you run a search using the Full Text Search feature. To create a Search 

report, click the Report button ( ) on the Main Menu toolbar, then choose Full Text Search from the menu. 
See ”Working with Full Text Search” on page 29 for information on running searches. 

Type To retrieve

gr*w grew
grow

Type To search for transcripts that contain

& (AND) both terms

a space (OR) either term or both terms

/n terms within n terms of each other (where n is a number)

+n the first term preceding the second by n terms (where n is a number)

“ ” terms appearing in the same order as in the quotation marks

Type To exclude transcripts that contain

% (BUT NOT) the terms following the percent symbol
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8 Working with Auto Tags

Use Auto Tags to automatically highlight words or phrases as they appear in a transcript.

Creating Auto Tags 
To create an Auto Tag, complete these steps: 

1. Choose Auto Tags from the Annotate menu. The Auto Tags dialog box is displayed (Figure 8-1). 

Figure 8-1. Auto Tags dialog box

2. Click New. Then type the word or phrase you want to add to the Auto Tags list. 

3. Select the Show Auto Tags check box to highlight Auto Tags in the transcript. 

4. Click the Color arrow to select a color, if desired. 

5. Click OK to save your changes. Your Auto Tags will be highlighted automatically throughout the 
transcript(Figure 8-2). 

Figure 8-2. Auto Tags

Managing Auto Tags 

SHOWING AND HIDING AUTO TAGS 

If you choose not to show Auto Tags when you create them, you can show them by choosing Auto Tags from the 
Annotate menu. The Auto Tags dialog box is displayed. Select the Show Auto Tags check box and click OK. To hide 
Auto Tags, clear the Show Auto Tags check box. 

DELETING AUTO TAGS 

To delete an Auto Tag, complete these steps: 

1. From the Annotate menu, choose Auto Tags to display the Auto Tags dialog box. 

2. Select the Auto Tag you want to remove and click Delete. 

3. Repeat step 2 for each Auto Tag you want to delete. 
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4. Click OK to save your changes. 

Creating an Auto Tag Report 
This report lists all occurrences of the words and phrases in a transcript for which Auto Tags were created, 
arranged in page and line order. To create an Auto Tag report, complete these steps:

1. Click the Report button ( ) on the Main Menu toolbar, then choose Auto Tags from the menu. The 
Auto Tag Report Properties dialog box is displayed (Figure 8-3). 

Figure 8-3. Auto Tag Report Properties dialog box 

2. Click the Data tab to display a list of transcripts and documents. By default, all document types and data are 
selected. To exclude a document type from the report, clear its check box. To exclude particular data from 
the report, click the document type containing the data, then clear the check boxes for the data you want to 
exclude. 

3. Click the Display tab to view a list of display options. Type a title for the report in the Title text box, if desired. 
Then select or clear the appropriate check boxes. 

4. Click the Context tab to display a list of context options. Select or clear the appropriate check boxes. 

5. Click OK. The Auto Tag report, which includes the lines with the Auto Tags and the surrounding questions 
and answers, is listed under Report in the left pane and the text of the report is displayed on the Report tab 
in the right pane.
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9 Working with Data Groups 

You can organize transcripts, documents, and annotation notes into groups. For example, you can create groups 
based on the different types of witnesses in a case, such as character witnesses and expert witnesses. When you 
assign data to a group, the data is displayed under the group folder in the left pane (Figure 9-1). You can also 
select a group when you are preparing reports or creating searches to ensure all the transcripts, documents, and 
annotation notes you need are included. 

Figure 9-1. Documents organized into data groups

Creating a Data Group 
To create a data group, complete these steps: 

1. Click the New arrow on the Main Menu toolbar, then choose Data Group from the menu. The Data Group 
Properties dialog box is displayed (Figure 9-2). 

Figure 9-2. Data Group Properties dialog box

2. Type the name of the group, e.g., Character witnesses, in the Name text box.

3. By default, all transcripts, documents, and annotation notes are selected. To exclude a document type from 
the group, clear its check box. To exclude particular data from the group, click the document type containing 
the data, then clear the check boxes for the data you want to exclude.

4. Click OK. 
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Editing Data Groups 
To add document types and data to a group or remove them from a group, complete these steps: 

1. From the Tools menu, choose Manage Data Groups. The Data Groups dialog box is displayed. 

2. Select the group you want to edit and click Edit. The Data Group Properties dialog box is displayed. 

3. Select or clear the appropriate check boxes and click OK. 

4. Click OK again in the Data Groups dialog box. 

Using Data Groups in Reports 
To create a report using data groups, complete these steps: 

1. Click the Report button ( ) on the Main Menu toolbar, then choose the type of report you want to 
create, e.g., Issues. 

2. In the dialog box that is displayed, click the Data tab, then click Groups. The Data Groups dialog box is 
displayed. 

3. Select the group or groups you want to include in the report and click OK. 

4. Click OK again to create the report. 

Using Data Groups in Full Text Searches 
You can run full text searches using data groups. To conduct a search using data groups, complete these steps: 

1. From the Search menu, choose Full Text Search. The Full Text Search Properties dialog box is displayed. 

2. Type a search in the Terms text box, or choose a search from the Recent drop-down list.

3. Click the Data tab, then click Groups. The Data Groups dialog box is displayed.

4. Select the group or groups you want to include in the search and click OK. The Full Text Search Properties 
dialog box is redisplayed.

5. Click OK to run the search.

See ”Working with Full Text Search” on page 29 for more information on using the Full Text Search feature.

Sorting by Data Groups
Use the Sort by Data Groups feature to view transcripts, documents, pleadings, and research documents sorted 
by data groups. For example, to view documents listed in the data groups, click Documents in the left pane, then 
click the arrow next to Sort By Title and choose Sort By Data Groups from the menu. The documents are listed in 
the data group folders to which they were assigned.
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10 Transferring Transcript and Document Text

You can copy the text of a transcript or document and paste it into other applications. You will need to make 
certain that the appropriate button used for copying text is displayed. To display the button, click the Annotate 

Mode button ( ) on the toolbar above the transcript or document in the right pane, then choose the 
appropriate button from the menu (Figure 10-1), as discussed below. The menu choices will vary depending on if 
you are viewing a transcript or document.

Figure 10-1. Copy buttons

Transferring Text of a Transcript
When viewing a transcript, you can transfer the transcript citation with the text, which includes the following 
details:

• name of the transcript

• page number (or numbers if copied text spans more than one page) 

• line numbers 

• date of the transcript

To transfer transcript text with the transcript citation, complete these steps: 

1. Make certain the Copy (with Page and Line) button ( ) is displayed. 

2. Select the text you want to copy. 

3. Open an outline in West Case Notebook or open another application and paste the text you have copied. For 
example, to paste the text into Microsoft Word, press Ctrl+V or choose Paste from the Edit menu in Word 
(Figure 10-2). 

Figure 10-2. Transcript text with citation in Word

Transferring Text of a Document
To transfer the text of a document that is a word-processing document, complete these steps:

1. Make certain the Copy button ( ) is displayed. 

2. Select the text you want to copy. 
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3. Open another application and paste the text you have copied. For example, to paste the text into Microsoft 
Word, press Ctrl+V or choose Paste from the Edit menu in Word. 

If you are viewing a document that is an image file or PDF file, you can transfer a portion of the document. To 
transfer a portion of a document, complete the following steps:

1. Make certain the Select Mode button ( ) is displayed. 

2. Select the part of the document you want to copy. 

3. Choose Copy from the Edit menu.

4. Open another application and paste the text you have copied. For example, to paste the text into Microsoft 
Word, press Ctrl+V or choose Paste from the Edit menu in Word. 
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11 Using the Word Index 

The Word Index contains an index of words and numbers in a transcript along with their corresponding page and 
line numbers (Figure 11-1). When you are connected to Realtime, the Word Index is updated every 15 seconds. Use 
the Word Index to search for a term in the transcript. Type the term in the text box to the right of the transcript to 
display the pages and lines where the term is found in the transcript. 

To see the term in context, point to the page and line reference. The question and answer in which the term 
appears is displayed. 

Note If you do not see the question and answer in which the term appears, you must change the Word Index 
display options. For further information, see “Selecting Word Index Display Options” below.

To display the term in the transcript, click the page and line reference. 

Figure 11-1. Word Index

Selecting Word Index Display Options
To select Word Index display options, choose Display Options from the View menu to display the Display Options 
dialog box (Figure 11-2). Click the Word Index tab. You can specify 

• whether you want to see your term in context when you point to the page and line reference in the Word 
Index

• how much transcript text you want displayed when viewing a term in context in the Word Index. If you select 
QA Pair, the entire question and answer in which the term appears is displayed. In the alternative, you can 
designate the number of lines to be displayed above and below the term 

• the types of documents in which to display the Word Index 

Click OK to save the Word Index display options.

Figure 11-2. Display Options dialog box

Type the term you want to 
search for in the Word Index 
text box.

Point to the page and line 
reference to see your term in 
context.
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12 Connecting to Realtime 

Connecting with a Serial Connection 
If you want to connect to Realtime using serial cables, your computer must have a serial port. If you have only a 
USB port available, you will need to provide a USB to serial adapter. (For information about serial adapters, 
download a free copy of Connecting to Realtime: West Case Notebook/West LiveNote at west.thomson.com/
support/user-guide/livenote-case-notebook.aspx.) If a USB to serial adapter is not available, you can connect 
to Realtime over the Internet via LiveNote Stream. Contact the court reporter to schedule the session. 

To connect to Realtime using serial cables, complete these steps: 

1.  Click the New arrow on the Main Menu toolbar, then choose Realtime Transcript from the menu. The 
Connect to Realtime dialog box is displayed (Figure 12-1). 

2.  Select Serial. The court reporter will give you the necessary settings for connecting to the reporter’s CAT 
(computer–aided transcription) system. You will need to know the required serial port setting. 

3.  Click Connect to connect to Realtime. 

Using LiveNote Stream 
LiveNote Stream allows you to connect to Realtime via the Internet. You can access LiveNote Stream through 
West LiveNote software or through Microsoft Internet Explorer. 

The court reporter must schedule the session 24 hours in advance if you want to use LiveNote Stream to view 
transcript text or 72 hours in advance to view video and text. LiveNote Central will send you an e-mail with the 
required username and password. 

Note In order to view the video segment, you must use Internet Explorer and Windows Media Player 9 or later. 
You must also unblock pop-up windows. 

Figure 12-1. Connect to Realtime dialog box
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ACCESSING LIVENOTE STREAM THROUGH WEST LIVENOTE

To connect to Realtime using LiveNote Stream through West LiveNote, complete these steps: 

1.  Click the New arrow on the Main Menu toolbar, then choose Realtime Transcript from the menu. The 
Connect to Realtime dialog box is displayed (Figure 12-2). 

2. Select LiveNote Stream. 

3. Select the check box next to Play live video (if available).

4. Click Connect to display the LiveNote Stream Login dialog box. 

5. Type the username and password sent to you by LiveNote Central and click OK to display the Connect to 
LiveNote Stream dialog box. 

6. Select the session you want to attend and click OK. 

ACCESSING LIVENOTE STREAM THROUGH INTERNET EXPLORER 

You do not need West LiveNote software to access LiveNote Stream through Internet Explorer. 

To access LiveNote Stream through Internet Explorer, complete these steps: 

1.  Go to www.livenote.com/stream.

2.  Type the username and password sent to you by LiveNote and click Go to display a list of your sessions. 

Figure 12-2. Connect to Realtime dialog box
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3.  Select the session you want to attend and click Go. The Realtime transcript text and video are displayed 
(Figure 12-3). 

Figure 12-3. LiveNote Stream

ACCESS TO FEATURES IN LIVENOTE STREAM

When you view access LiveNote Stream using Internet Explorer, you are able to hear the audio and see the video 
and streaming transcript text. You can also stop and start the transcript text. When you access LiveNote Stream 
using West LiveNote software, you have access to all the tools in West LiveNote. Below is a chart showing the 
features available with LiveNote Stream.

 West LiveNote
Features

LiveNote Stream
Through Internet Explorer

LiveNote Stream
Through West LiveNote

Audio

Video

Instant messaging

Streaming transcript text

Start and stop text

Word Index

Saved transcript

Quick Marks

Issue Marks

Annotations

Auto Tags

Full Text Search

Reports
Connecting to Realtime      41



13 Working with a Transcript in Realtime 

West LiveNote provides you with tools that are easy to use even when you are working with a transcript in 
Realtime. You can stop and start the scrolling text, annotate the text, and do quick word searches at the same 
time that you are listening to what the deponent or witness is saying. You can also annotate and search existing 
transcripts. 

Starting and Stopping Text 
To stop the scrolling transcript (Figure 13-1),

• click Pause on the toolbar above the transcript

• press the Esc key

To browse the text of the transcript,

• use the scroll bar on the right

• press the Page Up and Page Down keys

• press the arrow keys

• press Ctrl+Home to go to the top of the text

• press Ctrl+End to go to the end of the text

To restart the scrolling transcript,

• click Pause

• press the Esc key 

Figure 13-1. Starting and stopping transcript text

Using Quick Marks 
Quick Marks are marks at the line number in the margin of a transcript. They are the simplest form of annotation 
in West LiveNote and are displayed as a solid bar in the default Quick Mark color. You can use them as place 
markers in the text for which you can run searches and generate reports. 

To insert a Quick Mark (Figure 13-2)

• press the spacebar on your keyboard 

• click a line number 

A complete list of all Quick Marks in a transcript is located in the Annotations folder under the transcript in the 
left pane. Click the plus symbol (+) next to the transcript to view the Annotations folder. Double-click a Quick 
Mark reference in the folder to jump to the Quick Mark in the transcript. 

To stop the scrolling text, click Pause or 
press the Esc key. To restart the scrolling
text, click Pause or press the Esc key 
again

Use the scroll bar to browse the text of 
the transcript.
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To delete a Quick Mark, click it in the margin of the transcript. 

Figure 13-2. Quick Mark

Quick Marks Report 
This report lists all Quick Marks and Issue Marks in a transcript, arranged in page and line order. 

To create a Quick Marks report for the transcript you are viewing, click the Quick Mark Report button 

( ) on the toolbar above the transcript in the right pane. The report is displayed on the Report tab in 
the right pane. 

To create a Quick Marks report for one or more transcripts, complete these steps:

1. Click the Report button ( ) on the Main Menu toolbar, then choose Quick Marks. The Quick Mark 
Report Options dialog box is displayed (Figure 13-3).

Figure 13-3. Quick Mark Report Options dialog box

2. All of the issues in the case are selected on the Issues tab by default. To exclude an issue from the report, 
clear its check box.

3. Click the Data tab to display a list of transcripts. By default, all transcripts are selected. To exclude a 
transcript from the report, clear its check box.

4. Click the Display tab to view a list of display options. Type a title for the report in the Title text box, if desired. 
Then select or clear the appropriate check boxes. 

5. Click the Context tab to display a list of context options. Select or clear the appropriate check boxes. 

6. Click the Authors tab to display a list of annotation authors. If you are working in a secure case on a network, 
a list of all annotation authors is displayed. If you are working in the case offline, just LocalUser is displayed. 
Select or clear the appropriate check boxes.

Press the spacebar or click 
a line number to place a 
Quick Mark in the margin 
of the transcript.

Double-click a Quick Mark 
reference to jump to its 
location in the transcript.
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7. Click OK. The Quick Marks report, which includes the lines you marked and the surrounding questions and 
answers, is displayed on the Report tab in the right pane. 

Using Issue Marks 
An Issue Mark is a mark at the page and line number in the margin of a transcript that corresponds to a particular 
issue on the Main Menu toolbar. The Issue Mark color is the same as the color of the issue. To insert an Issue Mark, 
click an issue button on the Main Menu toolbar, then click a line number 
(Figure 13-4). 

A complete list of all Issue Marks is located in the Annotations folder in the left pane. Click the plus symbol (+) 
next to the transcript to view the Annotations folder. Double-click an Issue Mark reference in the folder to jump to 
the Issue Mark in the transcript. 

To delete an Issue Mark, click it in the margin of the transcript. 

Figure 13-4. Issue Mark

Click an issue button on 
the Main Menu toolbar, 
then click a line number 
to place an Issue Mark in 
the margin of the 
transcript.

Double-click an Issue 
Mark reference to jump 
to its location in the 
transcript.
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14 Working with Video in Transcripts

Playing Video Segments 
If the transcript you are viewing has a video associated with it, you can view the portion of the video that is 
synchronized with the transcript. To view the video, right-click anywhere in the transcript, then click Play Video. 
To play a video segment that is associated with an annotation, right-click in the annotation and choose Play 
Video Segment from the menu.

Creating Annotation Video Segments 
If a transcript has been synchronized with video, you can convert the transcript text to a video segment and save 
it. You can create a single video segment from a single annotation or create multiple video segments from an 
Annotations report. 

CREATING A VIDEO SEGMENT FROM A SINGLE ANNOTATION 

To create a single video segment from an annotation, complete these steps: 

1. Double-click an annotation in the left pane. The highlighted text of the annotation is displayed in the right 
pane. 

2. Right-click in the annotation. 

3. From the menu that is displayed, choose Send. Then choose Video File from the submenu. The Save As 
dialog box is displayed.

4. Select a location for the file. 

5. Type a different file name in the File name text box, if desired.

6. Click Save. The message Would you like to view the new video clip now? is displayed. 

7.  Click Yes to view the video segment. 

CREATING MULTIPLE VIDEO SEGMENTS FROM AN ANNOTATIONS REPORT

To create multiple video segments from an Annotations report, complete these steps: 

1. In the left pane, right-click the Annotations folder, then click Report. The Annotations report is displayed on 
the Report tab in the right pane.

2. Click Send at the top of the report, then choose Video File from the menu. The Save As dialog box is 
displayed. 

3. Select a location for the file.

4. Type a different file name in the File name text box, if desired. 

5. Click Save. The message Video files saved successfully. Would you like to open the containing folder now? is 
displayed. 

6. Click Yes to open the folder in which the video segments are stored. The page and line ranges are added to 
the video segments. 
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EDITING VIDEO SEGMENTS

To edit the start and end time for a video segment that is associated with an annotation, right-click in the 
annotation and choose Edit Annotation from the menu. The Annotations Properties dialog box is displayed. Click 
the Video tab and make your changes in the appropriate text boxes, then click OK. (Figure 14-1).

Figure 14-1. Annotations Properties–Video tab

Transferring Annotations to Microsoft PowerPoint 
You can transfer annotations and video segments to Microsoft PowerPoint and have them embedded in 
PowerPoint slides. Each annotation creates a separate slide. You can create a slide from a single annotation or 
multiple slides from an Annotations report. 

Note It is recommended that you use short annotations for each PowerPoint slide. If you need a longer excerpt, 
transfer multiple annotations from a report to create a single PowerPoint presentation with a slide for 
each annotation. 

Also, when you transfer annotations to PowerPoint from transcripts with associated videos, you have the option 
of saving both the PowerPoint file (PPT) and the video clip (WMV). If you want to share the PowerPoint 
presentation with someone else, you must include the associated WMV file for the embedded video to play. 

CREATING A POWERPOINT PRESENTATION FROM A SINGLE ANNOTATION 

To create a PowerPoint presentation from an annotation, complete these steps: 

1. Double-click an annotation in the left pane. The highlighted text of the annotation is displayed in the right 
pane. 

2. Right-click in the annotation and choose Send from the menu and PowerPoint from the submenu. The Save 
As dialog box is displayed. 

3. Select a location for the file.

4. Type a different file name in the File name text box, if desired. 

5. Click Save. The message Would you like to open the presentation now? is displayed. 

6. Click Yes to view the PowerPoint presentation. To create another PowerPoint presentation, close 
PowerPoint. 

CREATING A POWERPOINT PRESENTATION FROM AN ANNOTATIONS REPORT 

To create a PowerPoint presentation from an Annotations report, complete these steps: 

1. In the left pane, right-click the Annotations folder, then click Report. The Annotations report is displayed on 
the Report tab in the right pane. 

2. Click Send at the top of the report, then choose PowerPoint from the menu. The Save As dialog box is 
displayed. 
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3. Select a location for the file.

4. Type a different name for the file in the File name text box, if desired.

5. Click Save. The message Would you like to open the presentation now? is displayed. 

6. Click Yes to view the PowerPoint presentation. To create another PowerPoint presentation, close 
PowerPoint. 

SAVING POWERPOINT FILES WITH THE SAME NAME 

If you save a PowerPoint file with a name that already exists, the Existing PowerPoint File dialog box is displayed. 
Select Append slides to existing presentation to add slides to the existing presentation.
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Appendix 

Using Issues to Create an Errata Report
The deponent has the option of reviewing the transcript after the deposition. If the deponent finds errors in the 
transcript, you can easily mark those places in the transcript and create an Errata report. To create an Errata 
report, complete these steps: 

1. Create an issue named Errata (see ”Working with Issues” on page 20) and prioritize it to add it to the Main 
Menu toolbar.

2. Make certain the Annotate Mode button ( ) is displayed on the toolbar above the transcript in the right 
pane. 

3. Click the Errata button on the Main Menu toolbar to select it. 

4. Select the text in the transcript that the deponent reports is in error. The Annotation Properties dialog box is 
displayed. 

5. Type any information regarding the error in the Note text box, e.g., Witness says name should be Joan, not 
John. Click OK. 

6. Right-click the Annotations folder under the transcript in the left pane and click Report. The report is listed 
under Report in the left pane and the text of the report is displayed on the Report tab in the right pane. 

7. Click the Properties button ( ) on the toolbar above the report in the right pane to display the All 
Annotations Report Properties dialog box. 

8. On the Issues tab, clear all check boxes except the Errata check box.

9. Select the Only include Annotations with all selected issues (“Match all Issues”) check box.

10. Click OK. The report is redisplayed on the Report tab in the right pane with only the Errata annotations. 
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Converting RealLegal Binder Cases to West LiveNote Cases
When you open a RealLegal Binder case in West LiveNote version 1.1 or later, the properties for the case may or may 
not be converted. The following chart describes how the RealLegal Binder case properties are converted.

ITEMS THAT ARE CONVERTED ITEMS THAT ARE NOT CONVERTED

Transcripts Transcripts

• transcript text • transcript properties: Time, Plaintiff, 
Defendant

• transcript properties: Type, Status, Last, 
First, Volume, Date, Title, Taking Attorney, 
For, Comment

• links to documents from transcripts

• signature for signed transcripts 
(version 7.0 and later)

• video sync information

Documents Documents

• document contents • document properties: Title

• document properties: Type, Author, 
Recipient, Bates Range, Date, OCR 
information

• exhibit check box data, exhibit number, 
exhibit prefix

Annotations Annotations

• all annotations • chronology date

• issues, including name and color • active issue properties

• attachment URLs are preserved

• comments converted to notes

• annotations authors only converted when 
imported into a secure case

Search groups Search groups

• search groups converted to data groups

• search group name converted to data group 
title

• transcripts and documents from the search 
group converted to data group

• preprogrammed search groups that come 
with RealLegal Binder

• saved reports
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Prompts and Messages for Video and PowerPoint
You may receive the following warnings and error messages when transferring files as video or to PowerPoint. 

The file [PowerPoint file name] already exists. Do you want to append slides to existing presentation [or] 
overwrite existing file? 

In most cases you will want to append or add slides to the existing PowerPoint presentation. Refer to 
”Transferring Annotations to Microsoft PowerPoint” on page 46 for more information. 

The file is open in PowerPoint. Please close PowerPoint and retry. 

PowerPoint needs to be closed when you are creating a presentation or appending slides to an existing 
presentation. 

The folder already contains file named [video file name]. Would you like to replace this file? 

This error usually occurs when you try to transfer the same annotation twice or when you try to save over an 
existing PowerPoint presentation. If you do not want to replace the file, you can cancel the transfer and review 
the annotation to make sure nothing has changed and then resave the file, or you can save the file to a different 
folder. 

Synchronized video is not associated with this transcript. 

The video has not been synchronized with the transcript. A synchronized video is a video that plays in sync with 
the transcript; i.e., as the person in the video speaks, the transcript scrolls and highlights the spoken text. A utility 
(e.g., RealLegal Publisher) must be used to synchronize the video with the transcript; otherwise, the video plays 
but the transcript does not scroll. 

Video does not exist for this transcript. 

No video is associated with the transcript. You can transfer an annotation to PowerPoint, but not video. 

Cannot create clip from annotation that spans more than one  file. 

This is a catchall error message designed for unsupported scenarios. Please contact West LiveNote Customer 
Technical Support at 1-800-290-WEST (1-800-290-9378) and describe what you were doing when this error 
occurred. 

Video clips can only be created from MPEG and WMV video files. 

West LiveNote only supports specific types of video files. For example, you cannot create video clips from RM 
(Real) or AVI (Audio Video Interleave) files. 

Failed to create temporary PowerPoint template file! Error code %d. 

This error may occur when your hard drive is full or if you do not have access rights to the hard drive where you are 
attempting to transfer the file. 

In order to create PowerPoint slides, you must first install PowerPoint on this computer. 

PowerPoint must be installed before you can transfer annotations to PowerPoint. 
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Connecting to a Simulated Realtime Transcript
When West LiveNote is installed, it provides you with a demonstration case, which includes sample deposition 
transcripts, exhibits, preset issues, and simulation of a real-time deposition. You can use the simulated transcript 
to practice using the basic tools of West LiveNote. 

To access the simulation, complete these steps: 

1.  Access West LiveNote. 

2. When the Open Case dialog box is displayed, select Gil Bower v. DC Corporation and click OK. The case 
window is displayed. 

3. Click the New arrow on the Main Menu toolbar, then choose Realtime Transcript from the menu. The 
Connect to Realtime dialog box is displayed (Figure 0-1).

4.  Select Simulation, then click Connect. The deposition automatically begins transcribing in the right pane.

Note The transcript is titled Realtime by default and listed under Transcripts in the left pane. To change the title 
of the transcript, right-click it and choose Properties from the menu. The Transcript Properties dialog box 
is displayed. Type a different title for the transcript in the Title text box and click OK.

Figure 0-1. Connect to Realtime dialog box
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Trial Version of West Case Notebook
West LiveNote offers a trial version of its software that includes the functionality of West Case Notebook. In the 
trial version, you can

• connect to 15 Realtime sessions

• add up to three transcripts, 10 documents, five pleadings, 10 research files, 25 key facts, and 10 characters

• create Issue Marks, Quick Marks, and annotations

• use the Word Index, Auto Tags, and Full Text Search (not available for some file formats added to the trial 
version)

• insert exhibits, transcript questions, and Westlaw documents into an outline

• send key facts to West Case Timeline, Microsoft Word, or Corel WordPerfect

• generate reports

In the trial version, you cannot

• update transcripts, documents, pleadings, and research files

• create outlines

• delete any items from the demonstration case

• save transcripts as ASCII files

• create a new case

• close the current case and open another case

• export cases

• connect to the West LiveNote Repository

Notes

• A transcript printed from the trial version includes a Demo watermark.

• Optical character recognition (OCR) technology is not available in the trial version of West Case Notebook.
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